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1.0.0 ITS Home

Direct links to service line
categories need to be given
highest priority on the home
page users are coming

to the site primarily to get
information or help with
services. (Focus Groups)

There is a need to draw special

attention to new or timely content
that otherwise may be buried

a few levels down on the site.

A versatile spotlights section
may include links to any type

of content, including projects,
services, events, news, etc.
(Content Analysis)

Customers are coming to

the site primarily to solve
problems, and news should be
of secondary priority. (Focus
Groups and Advisory Group)
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SERVICES & SOLUTIONS

..... --® E-mail & Calendar »
Internet & Networking »
Voice & Video »

Web Publishing »

Data Storage »

Labs & Printing »

Academic Support »

Consulting & Professional Services »
Administrative Applications »

Security P

IMAGE

IMAGE

velestiscil ullupta.

MLATEST ITS NEWS

12/15/06  Title of a News Story »
12/14/06  Title of a News Story »
12/13/06  Title of a News Story »
12/12/06 Title of a News Story »
11/19//06  Title of a News Story »

More ITS News »

] Title of spotlighted content b
Feu feu feuis dolobor sim velestiscil ullupta. Dunt inibh ea commolore

doloborper aliquate exero eummy nulla feuis.

Title of spotlighted content »
Feu feu feuis dolobor sim velestiscil ullupta. Dunt inibh ea commolore

doloborper aliquate exero eummy nulla feuis. Feu feu feuis dolobor sim

EVENTS & TRAINING

12/15/06  Title of Upcoming Event »
12/15/06  Title of Upcoming Event »
12/15/06  Title of Upcoming Event »
12/15/06  Title of Upcoming Event »
12/15/06  Title of Upcoming Event »

More Events & Training »

TOP PICKS .

Title of top linked content » -

Title of top linked content »

Title of top linked content b

Title of top linked content »

Title of top linked content »

TOP SUPPORT ISSUES o

1215006 Title of Issue b
12/14/06  Title of Issue »
12/13/06  Title of Issue P

12/13/06 Title of Issue »

12/13/06 Title of Issue »

More Support Issues »

PROMO AREA
(Computer store, upcoming event,

case study, etc.)
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.+ Current Services Status

information should be easy for
customers to find. (Advisory
Group & Focus Groups)

" Users have a difficult time

finding links to log in to
services and want to be able
to find these links quickly.
(Focus Groups & Search
Engine reports)

There should be a search box

on every page. Search also
needs to retrieve better results.
(Focus Groups, Comparative
Analysis, Advisory Group)

.. A versatile “Top Picks” section

can provide links to important
content distributed across the
site. (Comparative Analysis,
Conent Analysis)

.""Quick links to top support

issues can help site visitors
solve problems quickly.
(Comparative Analysis)
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2.0.0 About ITS

The Departments section should
be removed from the top-level
navigation and located here

in the “About ITS” section.

The departments section

contains information about ITS
departments and is not a primary
way to navigate to ITS services.
(Focus Groups, Comparative
Analysis, Content Analysis)

In order to shift the site to a

more interactive approach

to communicating with our
community, the global “News”
section should be replaced by a
new section that enables 2-way
communication between ITS

and its customers and partners.
More formal News stories relating
to the organization should be
located in the “About ITS” section
and will also appear on the home
page. (Comparative Analysis,
Content Analysis)

The campus community is not i
aware of the many important
things ITS does to support the
UT Community. This section

will allow us to provide a broad
picture of ITS, as well as highlight
some of important services and
activities that may be invisible to
many of our customers. (Advisory
Committee)
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About ITS

% Organization » »
® IMAGE
Current News »
® Reports »
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Contact »
IMAGE
IMAGE
’ IMAGE
Mission

ITS and the UT Community

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis
lectus sed massa faucibus tempor. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit. More...

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis
lectus sed massa faucibus tempor. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit. More...

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis
lectus sed massa faucibus tempor. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit. More...

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis
lectus sed massa faucibus tempor. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit. More...

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis
lectus sed massa faucibus tempor. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit. More...

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit. Nulla facilisi. Aenean facilisis lectus sed massa faucibus
tempor. Lorem ipsum dolor sit amet, consectetuer adipiscing elit.

RECENT REPORTS
Title of Report

Title of Report

Title of Reports

CURRENT ITS PROJECTS
Name of Project
Name of Project
Name of Project

RELATED RESOURCES
Policies on VP-IT site ™.,

Related ltem

Related Item
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.- Customers need to know how

ITS is doing. In addition to the
annual report and survey results,
all reports on services will live

in the “About ITS” section, with
cross-links from the services
pages. (Advisory Group, Content
Analysis)

" Projects are an important piece

of defining who are are as an
organization, and should be
pulled in as related content
in this section. (Advisory
Committee)

* Since policies and other

important information may
reside on the VP-IT site,
cross-links should be provided.
(Content Analysis)
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2.1.0 Organization
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About ITS »

Current News »

About ITS: Organization

Reports »
“Departments” should no longer
be a primary way of navigating Jobs » ITS ORG CHART
the site. Rather than connecting
Contact »

specific services to departments,
a more general description of
organizational units should be
presented. (Content Analysis,
Comparative Analysis)

BUSINESS SERVICES »

Donec ornare ultricies purus. Nulla
facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem
ipsum dolor sit amet, consectetuer
adipiscing elit. Nulla facilisi.

Donec ornare ultricies purus. Nulla
facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem
ipsum dolor sit amet, consectetuer
adipiscing elit. Nulla facilisi.

OPERATIONS »

Donec ornare ultricies purus. Nulla
facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem
ipsum dolor sit amet, consectetuer
adipiscing elit. Nulla facilisi.

Donec ornare ultricies purus. Nulla
facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem
ipsum dolor sit amet, consectetuer
adipiscing elit. Nulla facilisi.

CUSTOMER SERVICES »

Donec ornare ultricies purus. Nulla
facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem
ipsum dolor sit amet, consectetuer
adipiscing elit. Nulla facilisi.

Donec ornare ultricies purus. Nulla
facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem
ipsum dolor sit amet, consectetuer
adipiscing elit. Nulla facilisi.
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3.0.0 Services & Solutions

Service lines and labels for
the groups should be those

determined by user input (Card

Sort, Focus Groups)

Services should be grouped by

tasks and topical relationships.
(Focus Groups, Card Sorts)

ITS customers often use other
names to identify our services

(e.g. “Webmail” instead of UMBS).

Special care must be taken to
label our services so that they are
identifiable to customers. (Focus
Groups, Card Sorts)

A service may appear in multiple
categories. (Card Sort, Focus
Groups)
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. Services & Solutions

®E.mail & Calendar »

UMBS (mail.utexas.edu), AEMS (austin.utexas.

_e €du), UT Mailing Lists, Group E-mail, Secure
“ E-mail

More...

Voice & Video »

Telephones, SmartVoice Voicemail, VOIP,
Long Distance Phone, Blackberry, Cable TV,
Satellite Programming, Video Conferencing

More....

Academic Support »

Blackboard, WebSpace, Thesis &
Dissertation Templates, Windows Terminal
Services, Statistics Consultin

More...

Web Publishing »

WebSpace, Windows Hosting, Unix Hosting,
Publishing on Web Central, SharePoint, TXShop,
UTnic, Database Services

More...

Administrative Applications »
Mainframe Accounts, Mainframe Printing,
Green Output, tn3270

More...

Internet & Networking »

Wired Networking, Wireless Networking,
ResNet, UT Mobile, Virtual Private Network

(VPN), Cabling, Co-location
More....

Labs & Printing »

Labs, Printing on Campus, Mainframe Printing,

Green Output, Labman, Lab Management
Services

More...

Consulting & Professional Services »

Onsite Support, Statistics Consulting,
Network Architecture Consulting, Server
Technical Support, Help Desk

More...

Data Storage »

Austin Disk Storage. WebSpace, Co-Location,
Tape Back-Up, Windows Terminal Services,
Database Services

More...

Security »

Information Security Office, Building Access
Control System, BevoWare, Austin Disk
Storage, Secure E-mail

More...

PROMOTIONAL
AREA

FEATURED EXPERT
ADVICE OR CASE
STUDY

FEATURED EXPERT
ADVICE OR CASE
STUDY

FEATURED EXPERT
ADVICE OR CASE
STUDY
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.- Case studies demonstrate the
“solutions” that ITS is able to
provide to its customers.
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3.1.0 Service Line

The Service Line page should -,
show relationships among :
services in a “scan-able” way.
This can be accomplished by
grouping services within task-
oriented sub-categories and
visually connecting services
which are variations of the
same general service type.
(Content Analysis, Focus
Groups, Comparative Analysis)

Some customers may need
additional information about this
topic before they are able to
select services. A prominent link
to a “What You Need to Know”
page (3.1.1) should be provided
prominently at the top of this
page. (Advisory Committee)

It should be easy for customers
to see “at-a-glance” the different
varieties of a service type

that are available. (Content
Analysis)

A more in-depth comparison -«
of service options should be
available in order to assist
customers in deciding on the

option that is right for them.
(Comparative Analysis)

Alink for “More Info” should
take users directly to the service
sub-site. The page also needs
to make it as easy as possible
for customers to sign up for
services. (Comparative Analysis,
Card Sorts, Focus Groups)
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* Web Publishing Services

o What You Need to Know »
7 Resources to help you get started with Web publishing services, along with tips & expert advice.

WEB HOSTING

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed massa faucibus
tempor. Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Vestibulum suscipit mi vel

Web Hosting Service Options = Help Me Choose »

WebSpace - Very brief description More Info » ‘Sign Up Now »
X -

Unix Hosting - Very brief description More Info » ‘Sign Up Now »

Windows Hosting- Very brief description More Info » Sign Up Now »

DATABASE
Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed massa faucibus
tempor. Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Vestibulum suscipit mi vel

Oracle - Very brief description More Info » Sign Up Now »
MySQL - Very brief description Ve i > Sign Up Now »
MS Access- Very brief description .. ® More Info » Sign Up Now »

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed massa faucibus
tempor. Lorem ipsum dolor sit amet.

UTnic- Very brief description More Info » Sign Up Now »
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SEARCH

RELATED RESOURCES ¥

Learn Web Publishing
UT Web Publishing Guidelines

Discussion Forums

CONSULTING & L4
PROFESSIONAL SERVICES

Web Team Consulting
Database Consulting

TOP SUPPORT ISSUES
Title of Support Issue
Title of Support Issue
Title of Support Issue

TRAINING OPPORTUNITIES
Training Opportunity
Training Opportunity
Training Opportunity
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""" Related resources such
as informational sites or
projects should be promoted
on each service line page.
(Comparative Analysis, Content
Analysis)

... Related consulting services
should be promoted on each
service line page. (Comparative
Analysis, Content Analysis)
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3.1.1 What You Need to Know

understanding our services within
the larger context of information
technology.

Expert Advice and Case Studies .,
will help more knowledgable

and experienced users discover
how to get more value from ITS
Services.

This page is the primary location
for Educational and Training
resources related to this topic.
The links will also appear as
“Related Links” on all the Service
pages that are part of this
Service Line.

Contact | Site Index | Staff Intranet

Current Service Alerts (0)
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SEARCH

~ Web Publishing: What you need to know

Rosto doloborero dit pratinibh eugiamet, consequat, consequ amcommodiat
dolum alisis nosto elenit la ate con eum zzriure deliqua tueraes sequip er ad do
commy nibh eum ipsusto et ut lamet numsan henim vel utatet ad eum veniat,
venisi.

Quis et ipsum ilis enim vullumm odoloborem zzrilit lorem zzriliquamet iustrud

enisi blan utpat lutet, vel eleniamet at, velit et ut dolor summy nullam, sustrud

Quis et ipsum ilis enim vullumm odoloborem zzrilit lorem zzriliquamet iustrud
enisi blan utpat lutet, vel eleniamet at, velit et ut dolor summy nullam, sustrud
dolorperat.

EXPERT ADVICE OR
CASE STUDY

EXPERT ADVICE OR
CASE STUDY

EXPERT ADVICE OR
CASE STUDY

4 Back to Web Publishing Services

Getting Started with Web Publishing ..
STEP1
Iquatis senit, sed ex eraessissi tat, vel illum
inis at vulput et, consequi el et wisl iustrud del

inci eros augait irit nit alit nisi tion volestrud
elenim zzriurer ad diam ent nullamc ommodip
eui blam do er auguer iure volor si bla
faciduipit laorperos eril utpat.

STEP 2

Quat. Faci ex exercin henibh eugiam zzrit aci
etuer sed tetue minim vel in veliquam quat.
Tat, vulla feuisi.

STEP 3

Tissenim ipit nim ectem vel eum zzrilis aut
aliscillum duipsus ciduisi smolorer ijustrud
min henisi eu faciduis nullaore dolut lutpat.
Rud magna feummy nulputem dolor adiamco

()
Related Resources

Link to a Resource
Brief Description of this Resource

Link to a Resource
Brief Description of this Resource

Link to a Resource
Brief Description of this Resource

Training Opportunities

Link to a Resource
Brief Description of this Resource

Link to a Resource
Brief Description of this Resource

Link to a Resource
Brief Description of this Resource

nsequat in ulluptate ercilit lore volum zzrillum
venis et am in utetue core deliquisi.
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N A simple step-by-step

explanation can help customers
who are new to this domain
select services they need.
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3.1.2 Service Comparison

The purpose of the Service
Comparison page is to provide
detailed information to a customer
comparing service options.
(Content Analysis, Comparative
Analysis)

Information about the “Features” .

of a service should be presented
separately from the service sub-
site. (Content Analysis)
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AVeb Hosting Service Options

4 Back to Web Publishing Services

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed massa faucibus tempor. Lorem ipsum
dolor sit amet, consectetuer adipiscing elit. Vestibulum suscipit mi vel risus. Nunc arcu. Pellentesque varius enim
at lectus semper fermentum. Ut vel augue non neque porttitor cursus. Lorem ipsum dolor sit amet, consectetuer

adipiscing elit. Nullam et quam.

Feature Comparison

Offered to Features Cost .
WebSpace e
Lorem ipsum dolor sit Students X amount of storage ~ FREE More Info » "WSign Up Now >
amet, consectetuer Faculty feature L
adipiscing elit. Staff e feaf® T
Unix Hosting
Lorem lpsum dolor sit Departments X amount of storage $ More Info » ‘ ‘Sign Up Now »
arr?e_t, c_onse;tetuer Faculty teature
adipiscing elit. Nullam Staff feature
et quam. Nullam et
quam.
Windows Hosting
Lorem ipsum dolor sit Students X amount of storage  $ More Info » ‘ ‘Sign Up Now »
amet, consectetuer Faculty PHP
adipiscing elit. Nullam Staff feature
et quam. feature
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=F~"“More Info” links take users

directly to the service sub-site,
where in-depth information about
the service can be found.

Customers can easily sign up
for service if this is enough
information to make a decision.
(Comparative Analysis, Card
Sorts, Focus Groups)
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3.3.0 Service Overview

One-click links to log on to the--...,
service (if available), sign up '
and manage accounts should

be placed prominantly on the
Service Overview page. This
supports the “shopping cart”

model that Web users are

familiar with. (Focus Groups,
Content Analysis, Comparative
Analsyis)

What You Need to Know
about Web Publishing »

Pellentesque varius enim at lectus semper
fermentum.

Ut vel augue non neque porttitor cursus. Lorem ipsum dolor sit amet,
consectetuer adipiscing elit.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.

Cost

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed
massa faucibus tempor.

Contact

Send e-mail to sharepoint@its.utexas.edu or call us at 555-5555.

Contact | Site Index | Staff Intranet
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SharePoint e
................... SharePoint Service
[oweviens ™ } — RELATED RESOURCES o
‘® Sign Up Now » Manage Account » Logon » L %
Getting Started » Learn Web Publishin )
. . i i i i A
Support » Overview of Benefits and Features ULieh Bl G icelines
Contracts & Reports » Donec ornare ultricies purus. Nulla facilisi. Discussion Forums
Aenean facilisis lectus sed massa faucibus
. . EXPERT ADVICE,
tempor. Lorem ipsum dolor sit amet, consectetuer
. . TESTIMONIAL, OR CONSULTING
adipiscing elit. ey —
Al WEb L) Vestibulum suscipit mi vel risus. Nunc arcu. \WebkleamiGonsulting
Services »
Database Consulting

TOP SUPPORT ISSUES .
Title of Support Issue ’
Title of Support Issue
Title of Support Issue

TRAINING OPPORTUNITIES
Training Opportunity
Training Opportunity
Training Opportunity
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“Related links provide

gateways to other services
and resources that may be
of interest. These related
links will be selected based
on which service line(s) the
service is part of. (Focus
Groups, Advisory Group)

N Eventually all support issues will

be stored in a knowledgebase,
and these links will provide a
quick way to access relevent
issues. (Comparative Analysis)
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3.3.3 Support for a Single Service

This page provides support
information focused on an
individual service. Eventually,

the content on this page would
be incorporated into the Help &
Support section of the site as part
of a Knowledge Base application.
(Comparative Analysis) Here, it
is shown in the Services section
based on the current structure of
the content (Content Analysis)
Further research and testing is
required. Regardless of where
the page finally “lives”, it will be
cross-linked from each section

of the site.

It is very important to inform
site visitors how to obtain more
information by contacting ITS
staff. (Focus Groups)

LOGOS & BRANDING
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SharePoint Service

Overview » Sign Up Now » Manage Account» | Logon »

Getting Started »

Contracts & Reports »

Troubleshooting

Vestibulum suscipit mi vel risus. Nunc arcu.

Pellentesque varius enim at lectus semper fermentum.

Contact | Site Index | Staff Intranet
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All Web Publishing Ut vel augue non neque porttitor cursus.

Services »

Pellentesque varius enim at lectus semper fermentum.

Ut vel augue non neque porttitor cursus.

Vestibulum suscipit mi vel risus. Nunc arcu.

® Need More Help?
Send E-mail to: sharepoint@austin.utexas.edu

Contact the ITS Help Desk

GET INVOLVED HELP & SUPPORT

SEARCH

RELATED RESOURCES
Learn Web Publishing
UT Web Publishing Guidelines

Discussion Forums

CONSULTING

Web Team Consulting
Database Consulting

TOP SUPPORT ISSUES
Title of Support Issue
Title of Support Issue
Title of Support Issue

TRAINING OPPORTUNITIES
Training Opportunity
Training Opportunity
Training Opportunity
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3.4.0 Consulting Service Overview

The navigation for consulting
service sub-sites needs to be
flexible to allow for different
type of services. (Content
Analysis)
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. . SEARCH i
Onsite Support Services e
P

Overview »

Services »
Contract Options »
@ Custom Navigation »

Custom Navigation »

All Professional &
Consulting Services »

What We Do

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit.

Benefits
Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit.

Vestibulum suscipit mi vel risus. Nunc arcu.

Pellentesque varius enim at lectus semper fermentum.

Ut vel augue non neque porttitor cursus.

Lorem ipsum dolor sit amet, consectetuer adipiscing elit.

Nullam et quam.

Comparison

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed
massa faucibus tempor. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit.

CONTACT US

Contact | Site Index | Staff Intranet

Current Service Alerts (0)

Contact by Phone

Contact by Email

Request Information

Schedule an Appointment

EXPERT ADVICE,
TESTIMONIAL, OR
CASE STUDY

Information Technology Services Contact | Jobs
Copyright © 2007 Information Technology Services | Privacy | Accessibility
Send computing questions to the ITS Help Desk or call (512) 475-9400.

Vice President for Information Technology »

Information Security Office »

Contact or details on how

to get more information
about these services

should be prominantly
displayed. (Advisory Groups,
Comparative Analysis)
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4.0.0 Software & Hardware

ITS customers expect to find a .
“Store” or place to go in order to *,

buy or download software. This
page will merge the information
in the Software Distribution

& Sales area of the ITS site
(http://www.utexas.edul/its/sds/
products/) with all other content
regarding the acquisition of
hardware and software. (Focus
Groups, Comparative Analysis,
Content Analysis)

Available products will be
grouped in categories that are
still TBD. (Comparative Analysis,
Content Analysis)

LOGOS & BRANDING

Contact | Site Index | Staff Intranet

Current Service Alerts (0)

STUDENTS »  FACULTY »  STAFF » VISITORS » DEPARTMENTS » IT COMMUNITY » ‘QUICK LOGIN ‘

ABOUT ITS SERVICES & SOLUTIONS

SOFTWARE & HARDWARE

IDs & ACCOUNTS

GET INVOLVED HELP & SUPPORT

*Software

Software Purchasing Details »

General Applications & Operating
Systems »

Name of Product, Name of Product, Name of
Product, Name of Product, Name of Product,
Name of Product, Name of Product

More....

.. Internet & Networking »
Name of Product, Name of Product, Name
of Product, Name of Product, Name of
Product, Name of Product, Name of Product

More....

Statistics and Mathematics »

Name of Product, Name of Product, Name of
Product, Name of Product, Name of Product,
Name of Product, Name of Product

More....

Hardware

Dell Blanket Purchase Ordering »
Apple Blanket Purchase Ordering »
Sun Blanket Purchase Ordering
Campus Computer Store »

Software Licensing Details »

A-Z list of Software »

Security Software »

Name of Product, Name of Product,
Name of Product, Name of Product,
Name of Product, Name of Product,
Name of Product

More....

Multimedia, Graphics and Publishing »
Name of Product, Name of Product, Name
of Product, Name of Product, Name of
Product, Name of Product,

More....

Database »

Name of Product, Name of Product, Name of

Product, Name of Product, Name of Product,
Name of Product, Name of Product

More....

CAMPUS COMPUTER STORE »

BEVOWARE »

.
SOFTWARE DISTRIBUTION & SALES »

TIMESHARE »

TOP PICKS
Name of Product »
Name of Product »
Name of Product »

Name of Product »

PROMO AREA
(featured specials at Campus
Computer Store, etc.)

Information Technology Services Contact | Jobs

Copyright © 2007 Information Technology Services | Privacy | Accessibility
Send computing questions to the ITS Help Desk or call (512) 475-9400.

Information Security Office P ‘

Vice President for Information Technology » ‘

Server search logs show that
site visitors have a difficult time
locating the Campus Computer
Store, so a prominant link
should be featured on this

page.

" Customers need to be able
to view all products from
all providers and also view
products from a single provider.
(Advisory Committee)
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4.1.1 Product Detall

Contact | Site Index | Staff Intranet

Current Service Alerts (0)

LOGOS & BRANDING
STUDENTS »  FACULTY »  STAFF » VISITORS » DEPARTMENTS » IT COMMUNITY »  QUICKLOGIN Webmail ‘ v
ABOUT ITS SERVICES & SOLUTIONS | SOFTWARE & HARDWARE IDs & ACCOUNTS GET INVOLVED HELP & SUPPORT
SEARCH

Apple Macintosh Operating System

Product pages need to provide
full disclosure on details of

licensing agreements. (Advisor i
censing ag (Advisory %] overview » PRODUCT OVERVIEW
Group, Content Analysis)
Purchasing Options » Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed massa
". Licensing Details » faucibus tempor. Lorem ipsum dolor sit amet, consectetuer adipiscing elit.
IMAGE
Help » Vestibulum suscipit mi vel risus. Nunc arcu. Pellentesque varius enim at lectus
semper fermentum. Pellentesque varius enim at lectus semper fermentum.
Pellentesque varius enim at lectus semper fermentum.
All General Applications &
Operating Systems » FEATURES
Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed massa
faucibus tempor. Lorem ipsum dolor sit amet, consectetuer adipiscing elit.
Vestibulum suscipit mi vel risus. Nunc arcu. Pellentesque varius enim at lectus
semper fermentum. Pellentesque varius enim at lectus semper fermentum.
Asingle productmay be e
available from ITS through |
multiple purchase options. It ® PURCHASE OPTIONS
is important for us to clearl .
1S Imp ) u _ Y Offered to Contract Period Cost
communicate the different
options to customers and help Apple Maintenance Program Faculty 3 years $19.67/year b chase Now »
them select the best option for Details about this purchase option.  Staff . .
their needs. (Advisory Group, License Details »
Content Analysis)

Campus Computer Store
(individual)

Details about this purchase option. License Details »

Purchase Now »

Campus Computer Store

(volume licensing) Purchase Now »

Details about this purchase option. License Details »

Information Technology Services Contact | Jobs . . X

Information Security Office »
Copyright © 2007 Information Technology Services | Privacy | Accessibility
Send computing questions to the ITS Help Desk or call (512) 475-9400. Vice President for Information Technology P
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5.0.0 IDs & Accounts

Contact | Site Index | Staff Intranet

Current Service Alerts (0)

LOGOS & BRANDING
STUDENTS »  FACULTY »  STAFF » VISITORS » DEPARTMENTS » IT COMMUNITY » QUICK LOGIN | Webmail ‘ v
ABOUT ITS SERVICES & SOLUTIONS SOFTWARE & HARDWARE IDs & ACCOUNTS GET INVOLVED HELP & SUPPORT
SEARCH
....... -+ |Ds and Accounts =R
ITS customers want a single -
place to obtain and manage any o )
type of account offered by ITS. Identification
(Focus Groups, Card Sorts)
UT EID (ELECTRONIC ID) UT PHOTO ID PROXIMITY CARDS
Do_n_e<_: ornare ultric_igs_ OIS TS Donec ornare ultricies purus. Nulla Donec ornare ultricies purus. Nulla
facilisi. Aenean facilisis lectus sed facilisi. Aenean facilisis lectus sed facilisi. Aenean facilisis lectus sed

massa faucibus tempor. massa faucibus tempor. massa faucibus tempor.
EID Management Tools
UT ID Center UT ID Center

Accounts

E-MAIL & CALENDAR» ACCOUNT RESOURCES
UMBS- Very brief description More Info » Sign Up Now » Manage » Acceptable Use Policy »

) o Description of this link
AEMS - Very brief description More Info » Sign Up Now » Manage »
Paying for Services »

Description of this link

VOICE & VIDEO » Billing Glossary »
Description of this link

SmartVoice (Voicemail)- Very brief description More Info » Sign Up Now » Manage »

WEB PUBLISHING »

WebSpace - Very brief description More Info » Sign Up Now »  Manage »
Unix Hosting - Very brief description More Info » Sign Up Now »  Manage »
Windows Hosting- Very brief description More Info » Sign Up Now »  Manage »

Information Technology Services Contact | Jobs I Sy O |3

Copyright © 2007 Information Technology Services | Privacy | Accessibility
Send computing questions to the ITS Help Desk or call (512) 475-9400. Vice President for Information Technology P
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6.0.0 Get Involved

Customers have a strong need
to know about projects that
impact them. (Focus Groups,
Advisory Group)

»CURRENT PROJECTS

Contact | Site Index | Staff Intranet
Current Service Alerts (0)
LOGOS & BRANDING
STUDENTS »  FACULTY »  STAFF » VISITORS » DEPARTMENTS » IT COMMUNITY » ‘QUICK LOGIN ‘
ABOUT ITS SERVICES & SOLUTIONS SOFTWARE & HARDWARE IDs & ACCOUNTS GET INVOLVED HELP & SUPPORT

Get Involved

TRAINING & EVENTS *

COMMUNITY FORUMS o

Title of spotlighted content » Title of spotlighted content »

Title of spotlighted content ».,

Feu feu feuis dolobor sim velestiscil

Feu feu feuis dolobor sim velestiscil
ullupta. Dunt inibh ea commolore
doloborper aliquate exero eummy
nulla feuis.

Feu feu feuis dolobor sim velestiscil
ullupta. Dunt inibh ea commolore
doloborper aliquate exero eummy
nulla feuis.

ullupta. Dunt inibh ea commolore
doloborper aliquate exero eummy
nulla feuis.

Title of Project P Title of Event »

Brief description of the project. Brief description of the event.

Title of Project » Title of Event »

Brief description of the project. Brief description of the event.

Title of Project » Title of Event »

Brief description of the project. Brief description of the even

Title of Project P Title of Event »

Brief description of the project. Brief description of the even

Title of Project » Title of Event »

Brief description of the project. Brief description of the even

All Projects » All Training & Events »

Title of Discussion »

Brief description of the discussion.

Title of Discussion »

Brief description of the discussion.

Title of Discussion »

Brief description of the discussion.

Title of Discussion »

Brief description of the discussion.

Title of Discussion »

Brief description of the discussion.

All Community Forums »

Information Technology Services Contact | Jobs

Copyright © 2007 Information Technology Services | Privacy | Accessibility
Send computing questions to the ITS Help Desk or call (512) 475-9400.

Information Security Office » ‘

Vice President for Information Technology » ‘

ITS needs to promote events
that are related to services

and projects. Upcoming events
(SmartVoice training, for
example) should be featured
here as well as within the
appropriate service pages.
(Content Analysis, Comparative
Analysis)

“ITS staff would like more ways

to get the larger IT community
involved in projects. A discussion
forum provides a place for
experts from both inside

and outside of ITS to share
knowledge about current projects
or other current topics. (Advisory
Group, Comparative Analysis)
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6.2.0 Project Overview

Project sub-sites require
flexibility in content and

navigation. (Content Analysis) ,

Project leaders strongly desire .,

some way of pulling in content
from SharePoint. At minimum,
a link to a SharePoint site
could be present. (Advisory
Committee)

Project leaders need a way to

easily and quickly publish the
latest news about a project.
Here, project news is handled
in a blog-like format. This
would also allow external users
to post comments, if the project
team would like this kind of
input. (Advisory Committee)

Contact | Site Index | Staff Intranet

Current Service Alerts (0)

LOGOS & BRANDING
STUDENTS »  FACULTY »  STAFF » VISITORS » DEPARTMENTS » IT COMMUNITY »  QUICK LOGIN ‘ Webmail ‘ v
ABOUT ITS SERVICES & SOLUTIONS SOFTWARE & HARDWARE IDs & ACCOUNTS GET INVOLVED HELP & SUPPORT

Windows Vista Project

Overview »

Project News »
Discussion Forum »
’ Custom Navigation LInk »

Get Involved »

R Project Team Login »

All Projects »

SEARCH

Project Overview RELATED RESOURCES e

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed massa
faucibus tempor. Lorem ipsum dolor sit amet, consectetuer adipiscing elit.

Link to Vista Resource

External Link to Vista
Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Lorem ipsum dolor sit  Resource
amet, consectetuer adipiscing elit. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit.

TRAINING OPPORTUNITIES
Latest Project News e

Training Opportunity K

.“.»'Title of News Item

posted on 1/18/07 by J. Smith Training Opportunity
Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit. More...

Comments (4)

Training Opportunity

Title of News Item

posted on 1/18/07 by J. Smith

Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Lorem ipsum dolor sit
amet, consectetuer adipiscing elit. Lorem ipsum dolor sit amet, consectetuer
adipiscing elit. More...

Comments (4

All Project News » Subscribe RSS » .

Latest Forum Posts e

1/18/07 Title of Discussion Forum Post

1/18/07 Title of Discussion Forum Post

1/18/07 Title of Discussion Forum Post

Vista Discussion Forum »

Information Technology Services Contact | Jobs
Copyright © 2007 Information Technology Services | Privacy | Accessibility
Send computing questions to the ITS Help Desk or call (512) 475-9400.

Information Security Office »

Vice President for Information Technology »

Related projects, services,
news and/or events should be
linked from each project site.
(Content Analysis)

" Many ITS customers prefer to

get news through RSS feeds.
(Focus Groups)
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7.0.0 Help & Support

Direct links to Support pages for

the most popular services should ™

be featured. (Comparative
Analysis, Focus Groups)

A knowledge base should be
used to manage and publish
support issues. In the early
implementation of the redesign,
a small database may be

used as an interim method of
managing the most important
support issues identified by ITS
staff. (Comparative Analysis,
Content Analysis)

Contact | Site Index | Staff Intranet

Current Service Alerts (0)

LOGOS & BRANDING
STUDENTS »  FACULTY »  STAFF » VISITORS » DEPARTMENTS » IT COMMUNITY » ‘QUICK LOGIN ‘
ABOUT ITS SERVICES & SOLUTIONS SOFTWARE & HARDWARE IDs & ACCOUNTS GET INVOLVED HELP & SUPPORT

Help & Support

® GET HELP WITH...

» Blackboard » Webspace
» UTEID

» E-mail

SERVICES STATUS

12/15/06  Title of a current service alert »

12/14/06  Title of a current service alert »

Services Status »

®TOP SUPPORT ISSUES

» Name of Service

» Name of Service

» Name of Service
» Name of Service

» Name of Service

Complete List »

Isit lut adionse quismod duis aut ad et am, volor adiating et iriuscin henit

Consenis delisi te consent in henisim dipisissed mod del incincipit la commy nonsed

Do corero consequam nosto od tat dolore minit wisim ex exer incidunt dign

At ullandre velit wis nit do odolorem dolorero cor ilis ex et ecte et am zzrit alit nostion

Ulputpation ex euisi tet wisit nibh et, quismod dunt la alit alissed mincil utate dit ad et, quat

Si blamcommodit alit, coreriure conse veros del il ex enibh er amconsequat, con venis

Nulluptatue dit ad tat utem iuscil dolesequi blandre rillaorerit ipit ero duis.

All Support Issues »

ITS HELP DESK
Hours

Isit lut adionse quismod duis
volor adiating et iriuscin henit

Contact

Phone: (512) 475-9400
Email

Chat

Walk-In

CONSULTING & PROFESSIONAL ¢
SERVICES

Onsite Support

Another Consulting Service
Another Consulting Service
Another Consulting Service
Another Consulting Service
All Consulting Services »

Self-Schedule an Appointment

Information Technology Services Contact | Jobs

Copyright © 2007 Information Technology Services | Privacy | Accessibility
Send computing questions to the ITS Help Desk or call (512) 475-9400.

Information Security Office » ‘

Vice President for Information Technology » ‘

Links to Consulting Services
" that may be associated with

“Help and Support” should be
cross-linked on this page for
customers who select this page
instead of Services & Solutions.
(Card Sorts, Focus Groups,
Advisory Group)
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8.0.0 Students

The Services for Audiences
page responds to the “Things
| Use” model of categorization
expressed by customers. (Card
Sorts)

Audience-specific spotlights
should highlight timely news,
projects, or services of interest
to a particular audience. (Focus
Groups)

Since we are separating
technical and non-technical
audiences on this type of page,
we have the ability use different
terminology and explanatory
language as appropriate.
(Advisory Group)

Contact | Site Index | Staff Intranet

Current Service Alerts (0)

LOGOS & BRANDING
FACULTY »  STAFF » VISITORS » DEPARTMENTS » [T COMMUNITY » | QUICKLOGIN = Webmail ‘V
ABOUTITS ~ SERVICES&SOLUTIONS ~ SOFTWARE & HARDWARE ~ IDs&ACCOUNTS ~ GETINVOLVED ~ HELP & SUPPORT
SEARCH

s Students

...... - Title of spotlighted content »
....... IMAGE Feu feu feuis dolobor sim velestiscil ullupta. Dunt inibh ea commolore

doloborper aliquate exero eummy nulla feuis.

Title of spotlighted content P
Feu feu feuis dolobor sim velestiscil ullupta. Dunt inibh ea commolore

doloborper aliquate exero eummy nulla feuis. Feu feu feuis dolobor sim
velestiscil ullupta.

IMAGE

SERVICES FOR STUDENTS

EMAIL SERVICES

Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed massa faucibus
tempor. Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Vestibulum suscipit mi

Personal Email Account Options | Help Me Choose »

UMBS - Very brief description, includes Webmail More Info » Sign Up Now »
Departmental Email- Very brief description More Info » Sign Up Now »

INTERNET & NETWORKING
"'-. Donec ornare ultricies purus. Nulla facilisi. Aenean facilisis lectus sed massa faucibus
tempor. Lorem ipsum dolor sit amet, consectetuer adipiscing elit. Vestibulum suscipit mi vel

Internet Connection Options | Help Me Choose »

Wired Public Network- Very brief description More Info » Sign Up Now »
Wireless Public Network- Very brief description More Info » Sign Up Now »
Resnet- Very brief description More Info » Sign Up Now »

TOP PICKS *

Manage your EID »

Protect Your Computer with

BevoWare »

Computer Repair Services »

Security Awareness »

TOP SUPPORT ISSUES

Title of a Support Issue P

Title of a Support Issue »

Title of a Support Issue »

Title of a Support Issue »

RESOURCES

Title of a Policy »
Title of a Policy »
Title of a Policy »

Title of a Policy »

Information Technology Services Contact | Jobs
Copyright © 2007 Information Technology Services | Privacy | Accessibility
Send computing questions to the ITS Help Desk or call (512) 475-9400.

Information Security Office »

Vice President for Information Technology »

The Top Picks section on this
page would be tailored for
the specific audience being
addressed.



